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Federal Communications Commissk ' '- " 

D A  05-2250 
August 4,2005 

WIRELESS TELECOMMUNICATIONS BUREAU GRANTS BROADBAND 
PERSONAL COMMUNICATIONS SERVICES (PCS) LICENSE 

Auction Event No. 58 

WT Docket No. 05-149 

Report No. AUC-58 (Auction No. 58) 

On February 15,2005, the Wireless Telecommunications Bureau (Bureau) completed the auction 
of 217 Broadband Personal Communications Services (PCS) licenses (Auction No. 58). '  On March 25, 
2005, the Bureau announced that, based upon a preliminary review, it had accepted for filing the long- 
form applications for winning bidders in Auction No. 58.2 Upon further review, we find that the 
application listed in Attachment A to this Public Notice is complete and conforms to the Commission's 
rules, Furthermore, the Commission has received full and timely payment, as required by Section 
1.2109(a) of its rules, 47 C.F.R. 3 1.2109(a), for the application listed in Attachment A,' We therefore 
find that the application listed in Attachment A to this Public Notice serves the public interest, 
convenience and necessity. 

Accordingly, we grant the application listed in Attachment A to this Public Notice pursuant to 
Section 309(a) of the Communications Act, as amended, 47 U.S.C. 5 309(a), and Section 0.331 of the 
Commission's rules, 47 C.F.R. 5 0.331. 

This Public Notice includes the following Attachments: 

Attachment A: The Application the Wireless Telecommunications Bureau is Granting - sorted by 
Applicant. 

Attachment B: Instructions for Searching for the Application Listed in Attachment A Using ULS. 

Attachment C: Instructions for Searching for Granted License Listed in Attachment A Using ULS. 

' Broadband PCS Spectrum Auction Closes: Winning Bidders Announced, Public Notice, 20 FCC Rcd 3703 (2005) 
(Closing PW. 
' Wireless Telecommunications Bureau Announces that Applications for Broadband Personal Communications 
Services (PCS) are Accepted for Filing, Public Norice, 20 FCC Rcd 6339 (2005). 

' Auction winners were directed to pay the balance of their winning bids in a lump sum by March 21,2005. Closing 
PN. 20 FCC RCD a1 3704. 

http://www.fcc.gov


Attachment D: Instructions for Accessing the FCC Network Using Windows 95/98, 

Please contact Erin McGrath, Wireless Telecommunications Bureau, Mobility Division, at (202) 
4 18-2042 for questions regarding legal matters and licensing issues. 
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AUCTION ID: 58 

SORTED BY LICENSEE NAME, MARKET NUMBER AND CHANNEL BLOCK 
DATE OF REPORT: AUGUST 4,2005 



Attachment B 

SEARCH INSTRUCTIONS FOR APPLICATIONS FOR AUCTION 58 

This attachment provides instructions for electronically searching the FCC Network for a 
specific application or applications on file with the Commission. The following instructions 
relate specifically to searching for applications filed in response to Auction 58. 

To search the FCC Network for an application, you must first connect to the FCC Network. 
Attachment C describes how Windows 95/98 users can connect to the FCC Network using the 
Dial-Up Networking features of Windows 95/98. 

We recommend that you use Netscape Communicator 4.7 or higher, or Internet Explorer 5.5 or 
higher (Internet web browser software) to use ULS for license searches. To download the latest 
versions of Netscape Communicator or Internet Explorer free of charge, access the Netscape 
download site at http://home.netscape.coni/dowrzlond/, or the Microsoft Internet Explorer 
download site at: http://www.microsoft.com/windows/ie/downlouds/default.asu. 

Conventions 

The instructions in this attachment use the following typographic conventions: 

bold Represents objects on the screen that you click with the mouse pointer, including 
buttons, Internet links, icon, tabs, menu items (e.g., Cancel button, Auctions link, 
Save option in the File menu). 

Represents field names or areas of a screen (e.g., Licensee Name field, Applicant 
Information area of a screen). 

Represents characters that you must type exactly as they appear in the 
instructions. For example, if you are instructed to type http://www.fcc.gov, you 
should type all of the characters shown in bold italic exactly as they are printed. 

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CmL, Esc). 

Note: Throughout these instructions, "enter" means to type the appropriate information and then 
press the ENTER key. 

italic 

bold italic 
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Performine an Application Search 

Once you have connected to the FCC Network, follow the procedures below to search for an 
application. You may click the ? (Help) button ai anytime for additional information on using 
Application Search. 

1. Connect to the FCC Network using one of the following options: 

Note: If your PC is connected to a network, you must use a secure proxy to access the 
FCC Network. Consult your Network Administrator. 

Dial-Uu Access 

a. Use Dial-Up Networking in Windows 95/98 to connect to the FCC Network (see 
Attachment C). 

Start your web browser. In the location field of the web browser screen, type 
htip://wtbwwW05.fcc.gov. Then press the ENTER key. 

b. 

Internet Access 

a. Start your web browser and connect to the Internet using your Internet Service 
Provider. 

In the location field of the web browser screen, type http://wireless.fcc.gov/uZs/. 
Then press the ENTER key. 

b. 

2. Verify that Java and JavaScript are enabled in your web browser preferences. 
Additionally, the preferences must specify “Accept all cookies.” Refer to your web 
browser Help facility for more information. 

On the Universal Licensing System main page, click the Search Applications button, 
located in the center of the page. 

Select the type of search by clicking the down arrow in the Select Search Type field to 
display the options menu. Select General and click the Continue button. 

The Application Search screen appears. This screen contains several data entry fields 
used for specifying the criteria for your application search. Specify the search criteria 
necessary to locate the desired application. Please refer to the following “Basic 
Guidelines for Specifying Search Criteria” for more information. 

3. 

4. 

5 .  
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If you are searching for an application filed for Auction 58, click 58 in the Auction ID 
field. 

Basic Guidelines for SDecifvine Search Criteria: 

e You must specify search criteria in at least one field. You do not have to specify 
search criteria in all of the search fields. Enter search criteria into as many fields 
as you wish. 

0 To specify search criteria in a search field containing a menu of options, click the 
desired option from the menu. Use the scroll bars to view all options in a menu. 
You can select multiple options from a menu by pressing the CTRL key while you 
click the menu options. 

Click <No Criteria> to undo a menu selection and search for all options in the 
menu. 

e 

. Click the Clear button to reset entries in all of the search fields. 

e The Universal Licensing System restricts the number of rows returned in an 
application search to 3000. 

Click the ? (Help) button for  a definition of each search field available on the Application 
Search screen. 

After you have specified the desired search criteria, click the Search button. The system 
will scan the database for any applications matching the search criteria. The matching 
application files will be listed on the Search Results screen. The Search Results screen 
will identify the file number, licensee name, application purpose, application status, radio 
service code, and receipt date for each application returned in the query. 

A message on the Search Results screen will indicate if no matches were found for the 
specified search criteria. Click the New Search button and re-specify search criteria. 

To view an application, click its file number link. To navigate through the data on the 
Application screen, use the scroll bar or click the links at the top of the screen. Click the 
? (Help) button for information regarding specific functions available on this screen. 

e 

6.  

7. 

To re-access the Search Results screen, click the down arrow end of the Other 
Options field to obtain the drop-down menu of options. Click Search Results 
from the Other Options menu and then click the Go button. 
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To begin a new search, click the down arrow end of the Ofher Options field to 
obtain the drop-down menu of options. Click New Search and then click the Go 
button. 

Technical Support 

For technical assistance in searching the ULS for applications, contact the FCC Technical 
Support Hotline at (202) 414-1250 (voice) or (202) 414-1255 (TTY). The FCC Technical 
Support Hotline is generally available Monday through Friday, from 8 a.m. to 6 p.m. ET. All 
calls to the FCC Technical Support Hotline are recorded. 
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Attachment C 

SEARCH INSTRUCTIONS FOR GRANTED LICENSES FOR AUCTION 58 

Following are instructions for electronically searching the FCC Network for a specific license or 
licenses on file with the Commission. The following instructions relate specifically to searching 
for granted licenses associated with Auction 58. 

To search the FCC Network for an application, you must first connect to the FCC Network. 
Attachment C describes how Windows 95/98 users can connect to the FCC Network using the 
Dial-Up Networking features of Windows 95/98. 

We recommend that you use Netscape Communicator 4.51,4.61, or 4.7 (Internet web browser 
software) to use ULS for application searches. To download Netscape Communicator 4.7 free of 
charge, access the Netscape download site at http://home.netscupe.com/downZoud/. 

Conventions 

The instructions in this attachment use the following typographic conventions: 

bold Represents objects on the screen that you click with the mouse pointer, including 
buttons, Internet links, icon, tabs, menu items (e& Cancel button, Auctions link, 
Save option in the File menu). 

Represents field names or areas of a screen (e.g.. Licensee Name field, Applicant 
Informarion area of a screen). 

Represents characters that you must type exactly as they appear in the 
instructions. For example, if you are instructed to type http://www.fcc.gov, you 
should type all of the characters shown in bold italic exactly as they are printed. 

SMALL CAPS Capital letters (in Roman without italics or bold lettering) inside French quotes 
indicate specific keys on the keyboard (e.g., <<ENTER,,> NCTRL,,) <<ESCn). 

iralic 

bold italic 
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Performing a License Search 

Once you have connected to the FCC Network, follow the procedures below to search for a 
license. You may click the ? (Help) button at anytime for additional information on using 
License Search. 

1, Connect to the FCC Network using one of the following options: 

Note: If your PC is connected to a network, you must use a secure proxy to access the 
FCC Network. Consult your Network Administrator. 

Dial-Up Access 

a. Use Dial-Up Networking in Windows 95/98 to connect to the FCC Network (see 
Attachment C). 

b. Start your web browser. In the location field of the web browser screen, type 
hftp://wtbwwwOS.fcc.gov. Then press the ENTER key. 

Internet Access 

a. Start your web browser and connect to the Internet using your Internet Service 
Provider. 

In the location field of the web browser screen, type http://www.fcc.gov/wtb/uZs. 
Then press the ENTER key. 

b. 

2. Verify that Java and JavaScript are enabled in your web browser preferences. 
Additionally, the preferences must specify "Accept all cookies." Refer to your web 
browser Help facility for more information. 

On the Universal Licensing System main page, click the License Search button, located 
on the left side of the page. 

Nofe:  License Search utilizes "cookies". If you are receiving a notification message 
when accepting a cookie, we recommend that you disable this message in your web 
browser options. Please consult your web browser Help facility for  more information. 

Select the type of search by clicking the down arrow in the Select Search Type field to 
obtain a menu containing the following options: 

Select General to search for all licenses 

Select Market Based to search only for licenses associated with an FCC Auction 

3. 

4. 
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Select Site Based to search only for site-based licenses 

Select Frequency to search for Wireless licenses based on a single frequency or 
frequency ranges. 

Click the desired option from the menu and click the Continue button. 

The License Search screen appears. This screen contains several data entry fields used 
for specifying the criteria for your license search. On the License Search screen, specify 
the search criteria necessary to locate the desired license. Please refer to the following 
“Basic Guidelines for Specifying Search Criteria” for more information. 

Basic Guidelines for Suecifvina Search Criteria: 

You must specify search criteria in at least one field. You do not have to specify search 

5 .  

criteria in all of the search fields. Enter search criteria in as many fields as you wish. 

To specify search criteria in a search field containing a menu of options, click the desired 
option from the menu. Use the scroll bars to view all options in a menu. You can 
select multiple options from a menu by pressing the CTRL key while you click the 
menu options. 

Click <No Criteria> to undo a menu selection and search for all options in the menu. 

Click the Clear button to clear entries from all of the search fields. 

The Universal Licensing System restricts the number of rows returned in a license search 
to 3000. In such instances, you must enter more specific search criteria to reduce the 
number of rows returned. 

Click the ? (Help) button for a definition of each searchfield available on the License 
Search screen. 

6 .  After you have specified the desired search criteria, click the Search button. The system 
will scan the database for any licenses matching the search criteria. The matching license 
files will be listed on the Search Results screen. The Search Results screen will identify 
the call sign, licensee name, radio service code, market, and licensee id for each license 
returned in the query. 

A message on the Search Results screen will indicate if no matches were found for the 
specified search criteria. Click the New Search button and respecify search criteria. 

To view a license, click its call sign underlined link. To navigate through the data on the 
License screen, use the scroll bar or click the links at the top of the screen. Click the ? 
(Help) button for information regarding specific functions available on this screen. 

7. 
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To re-access the Search Results screen, click the down arrow in the Other Options field 
to obtain the drop-down menu of options. Click Search Results from the Other 
Oprions menu and then click the Go button. 

To access additional information about the license (such as special conditions, associated 
applications, and locations), click the down arrow in the License Options field to 
obtain the drop-down menu of options. Click the desired selection from the menu 
then click the Go button. 

To begin a new search, click the down arrow in the Other Options field to obtain the 
drop-down menu of options. Click New Search from the Other Options menu and 
then click the Go button. 

Technical Support 

For technical assistance in searching the ULS for applications and licenses, contact the FCC 
Technical Support Hotline at (202) 414-1250. The FCC Technical Support Hotline generally 
will be available Monday through Friday, from 8 a.m. to 6 p.m. ET. All calls to the FCC 
Technical Support Hotline are recorded. 
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Attachment D 

USING DIAL-UP NETWORKING IN 
WINDOWS 95/98/2000/XP FOR ULS FILING 

This attachment describes how to use Windows 95/98/2000/XP Dial-Up Networking to establish a 
direct connection from your PC to the FCC Network and the Universal Licensing System (ULS) in 
order to file or review the Form 601. This point-to-point connection is not routed through the 
Internet. 

This direct dial-up connection is NOT required to perform ULS online filing. You may file or review 
Form 601 on the Internet by entering litto://www.fcc.aov/wtb/uls in your Web browser’s 
address/location bar and clicking the Online Filing button on the ULS homepage. 

Conventions 

The instructions in this section use the following typographical conventions: 

hold Represents objects on the screen that you click with the mot pointer, including 
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions link, 
Save option in the File menu). 

Represents field names or areas of a screen (e.g., Applicant field, Selected Licenses 
area of a screen). 

Represents characters that you must type exactly as they appear in the instructions. 
For example, if you are instructed to type http://www.fcc.gov/wtb/uls, you should 
type all of the characters shown in bold italic exactly as they are printed. 

Represents keys on the keyboard (e& ENTER, CTRL, EX) .  

italic 

bold italic 

SMALL CAPS 

Note: Throughout these instructions, “enter” means to type the appropriate information and then press 
the ENTER key. 
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Hardware and Software Requirements 

Connecting to the FCC Network using Windows 95/98 Dial-Up Networking requires at a minimum 
the following hardware and software: 

Hardware  Requirements 

CPU: Pentium 133 or above - RAM: 32 MB (more recommende, 
Monitor: VGA or above 

we mi ple applications open) 

Modem: 28.8 Kbps, Hayes-compatible or faster (recommend 56.6 Kbps) 
Mouse or other pointing device 

Software Requirements 

Web browser software is required. You may use Netscape Communicator (v. 4.5,4.5 1,4.61,4.7x) or 
Internet Explorer (v. 5.5or later) browser software to electronically register and file FCC Form 601 
through ULS. You can download Netscape Communicator free of charge by accessing the Netscape 
download site at htt~://home.netscaae.com/download/archive.html. You may also download Internet 
Explorer at htt~://www.microsoft.com/windows/ie/downloads/default.asD. 

Microsoft Windows 95/98/2000/XP 

Note: If you are running Windows in a networked environment, check with your local network 
administrator for any potential conflicts with Windows 95/98 Dial-Up Networking. This usually 
includes any TCP/IP installed network protocol. 

Adobe Acrobat 4.0 Reader (or higher) is recommended as a plug-in to your browser. This 
provides a viewer for displaying tiles related to applications, such as attachments and exhibits. For 
best results, install the plug-in after you have installed the desired web browser. This will allow 
the plug-in to be fully integrated within the browser wjndow. 

To download Adobe Acrobat version 4.0 or higher, access the Acrobat download site at 
httD://www.adobe.com/suaoort/downloads/main.html . 
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Confieuring Dial-Uo Networking 

1 .  To start dial-up networking in  Windows 95/98: 

a. Click the Windows 95/98 Start button. 
b. Click the Programs option to display the Programs menu. 
C. Click the Accessories option to display the Accessories menu. 
d. In Windows 95, click Dial-Up Networking. 

In Windows 98, click Communications, then Dial-Up Networking. 

If Dial-Up Networking is not an option on your Accessories menu, you should install it from 
your Windows 95/98 CD or diskettes. 

To Stan dial-up networking in Windows XP follow the steps below. 
a. Click the Start button. 
b. Click the Programs option to display the Programs menu. 
c. Click the Accessories option to display the Accessories menu. 
d. Click Communications 
e. Click New Connection Wizard. 
f. 
g. Click Dial-Up Connection. 
h. 

i. 
j. Select Connection Availability: 

Click Connect to the Network at My Workplace. 

Specify connection name by entering the name of the dial-up location in  the Comprmp 
Name field, e.g. “FCC Dial-Up Connection.” 
Enter dial-up phone number, 1-800-844-2784. 

Anyone’s use 
My use only 

To start dial-up networking in Windows 2000, the user must be logged in as an 
“administrator.” Follow these steps: 

a. Click the Start button. 
b. Click Settings. 
c. Click on the Network icon. 
d. Click on Dial-up Connections. 

NOTE: You must have administrative rights in Windows 2000 or XP to set up dial-up 
networking. 

2. When the Dial-Up Networking window appears, double-click the Make New Connection 
icon. 

The Make New Connection window appears 

In the field entitled Type a name for the computer you are dialing, type ULS at FCC. 

In Windows 95, click the down arrow at the right of the Select a modem field and select your 
modem from the menu of available modems. 

3. 

4. 
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5 .  

6. 

I .  

8. 

9. 

10. 

I I .  

12. 

13. 

14. 

15. 

In Windows 98, click the down arrow at the right of the Select a device field and select your 
modem from the menu of available devices. 

If your modem does not appear on this list, you must install your modem driver according to 
the modem manufacturer installation procedures, which are usually described in your 
modem’s user manual. 

Click the Configure button. Click the Options tab at the top of the Properties window 

In the Connection control area of the Options tab, verify that neither option is selected. If 
either option is selected, click the check box at the left of the option to deselect it. Then click 
the OK button. 

Click the Next button 

Type 800 in the Area Code field and 844-2784 in the Telephone Number field. Verify that 
the correct country is selected in the Country code field. If necessary, click the down arrow at 
the right of the Country code field, and select the appropriate country from the menu of 
available countries. 

Click the Next button. 

Click the Finish button. An icon titled ULS at FCC appears in the Dial-Up Networking 
window. 

Verify that properties are configured correctly before attempting a dial-up session. Position 
the mouse pointer on the ULS at FCC icon and click the right mouse button to display a 
menu. Select Properties from the menu. 

Click the Server Types tab at the top of the Properties window 

In the Advanced Options area, verify that only Enable sofnyare compression is selected 

If it is not selected, click the check box at the left of the option to select it. If either of the 
other options is selected, click the check box to deselect it. 

In the Allowed Nerwork Protocols area, verify that only TCP/lP is selected. 

If it is not selected, click the check box at the left of the option to select it. If either of the 
other options is selected, click the check box to deselect it. 

Click the TCPnP Settings button. In the TCPnP Settings window, confirm that the Server 
assigned I P  address option is selected. Then, in the section beneath, select Specify name 
server addresses. 



16. Type 192.104.54.1 as the Primary DNS. 

Make sure that these two options are checked: 

Use IP header compression 

Click OK on the TCPm Settings window and the Server Type window 

a. 

Use default gateway or remote network 

17. 

18. Click the Windows 95/98 Start button, then click the Settings option to display the 
Settings menu. 

Click Control Panel and then double-click the Network icon. 

In the Configuration tab of the Network window, select TCP//P and click the Properties 
button. (If there are multiple TCP/IP protocols, select TCP/IP, then highlight Dial-Up 
Adapter and click Properties.) 

d. Click the DNS Configuration tab. 

e. Select Enable DNS. Type bidder in the Host box, typefcc.gov in the Domain box, then 
type 192.104..54.1 in the DNS Server Search Order box and click the Add button. 

f. Click OK on the TCPlIF' Properties windows, then click OK on the Network window. 

g. If you are prompted to restillt your computer, click Yes 10 restart, then begin the Dial-Up 
Procedure. 

b. 

c. 

Dial-Up Procedure 

1 .  If the Dial-Up Networking window is not currently open, do the following: 

a. 
b. 
c. 
d. 

Click the Windows 95/98 Start button. 
Click the Programs option to display the Programs menu. 
Click the Accessories option to display the Accessories menu. 
In Windows 95, click Dial-Up Networking 
In Windows 98, click Communications, then Dial-Up Networking 

The Dial-Up Networking window appears. 

Double-click the ULS at FCC icon in the Dial-Up Networking window 

Click the Connect button on the window. D o  not enter User name and Password. 

The Connecting window appears, indicating the status of your connection as your modem dials 
into the system. This window must remain running during your dial-up session. You may 
minimize the window, if you wish. 

If your modem fails to establish a connection, please see the Troubleshooting section below. 

2. 

3. 
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4. 

5. 

Once the connection is established, open your Web browser. 

In your browser’s location field, enter http://wireless.fcc.gov/uls/ 

If nothing appears in your Web browser, see the Troubleshooting section below. 

When you have finished, exit the Web browser, then click the Disconnect button on the 
Connecting window to end your dial-up session. 

6. 

TroubleshootinP 

Following are problems you may encounter and possible solutions for resolving or isolating them. 

Modem does not respond 

1.  

2 .  

3. 

Confirm that all physical connections for the modem are present 

Confirm that the phone line is active by connecting it to a telephone and checking for adial tone. 

Confirm that the correct modem driver is installed for your modem. 

Modem dials hut does not connect 

1. 

2. 

Confirm that the number the modem is dialing is correct. 

Confirm that the modem prefix, if any, is correct. 

Modem dials and connects, but nothing appears when you enter the location in the Web 
browser 

1. Check the settings in your dial-up networking icon, particularly that the Primary DNS is 
192.104.54.1 and that TCP/lP is the only selected protocol. 

Confirm that your Web browser is not using proxies; it should be set to “direct connection to the 
Internet.” 

If you do log into a TCP/I?’LAN, confirm that your LAN network IP address is being released. 

To do so, connect to the FCC Network using dial-up networking, then click the Start button in 
Windows 95/98 and select Run. Type winipcfg and press OK. If your IP address does not 
begin with “192.104.”, then your LAN IF’ address is not being released. Click the Release All 
button, or consult your LAN administrator. 

2. 

3. 

Receive an Internal Server error in the Web browser 

1. Confirm that the address entered in the location field is correct (http://www.fcc.gov/wtb/u~). 
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2. Confirm that Java and JavaScript are enabled in your Web browser, and confirm that Cookies is 
set to Accept All. 

For technical assistance with installing or using FCC software, contact the FCC Technical Support 
Hotline at (202)-414-1250 (voice) or (202) 414-1255 (TIT). The FCC Technical Support Hotline is 
available Monday through Friday from 8 a.m. to 6 p.m. Eastern Time. There are no weekend hours 
and the hotline is closed all Federal holidays. All calls to the FCC Technical Support Hotline are 
recorded. 


